
	 85	

Appendix C  Transporting Figures 
 
Overview: 
 Almost every laboratory report needs figures of some sort.  These may be needed 
to describe an experimental apparatus, the schematic of a system to be tested, graphs of 
laboratory instrument data results, and plots of interpreted or mathematically 
manipulated results.  All of these kinds of figures ultimately need to be transported into 
the writer’s word processing program (here assumed to be Microsoft Word).  Porting 
figures from one program to another can be tricky.  There are usually multiple ways you 
can do it, including the following methods for getting a file or clip that you can paste 
into your laboratory report document: 

1.  Take a photo of the figure on the computer screen with a camera.  (Usually bad!) 
2. Take a screen shot (using “clipping tool”) on the computer to get an image file. 
3. Do a “copy” from the source program and “paste” directly into your document. 
4. Do a copy from the source and paste into a graphics program, fix it up a bit, then 

paste or insert it into your document. 
 
Complicating the issue is the fact that there are two very different forms of 

computer graphics: pixelated images, and line drawings.  An image composed of pixels 
is essentially a grid of points, each of which has a color.  This is typical for things like 
photographs.  The image is characterized by a resolution, typically given in “dots per 
inch” (dpi).  If such an image is stretched or zoomed too much, the individual pixels are 
apparent and the figure looks bad, possibly very bad.  (About 300 dpi is the normal 
standard for acceptable quality in print media, though lower resolution down to 100 dpi 
is sometimes OK.)  Graphics produced by digital photographs, screen shots, and many 
graphics pasted from other programs, are in the form of such images.  File formats such 
as .jpg, .tif, .png, etc. directly support pixelated images.  Figure C-1 shows the upper left 
corner of Figure 2 from Appendix E zoomed to 500%.  The pixels are quite visible. 

 
The other alternative is line drawings, in which the information is not stored as 

pixels, but as a list of lines and other shapes that compose the graphic.  An Excel chart is 
a line graphic, and so are drawings done in PowerPoint.  Line drawings are the basic 
representational principle in CADD software used for engineering.  The advantage is 
that you can zoom an arbitrary amount and sharpness is not lost.  Ultimately the 
drawings must be “rendered” to turn them into pixelated images for printing and 
display on a screen, but that transformation is made during display; the underlying 
representation remains line art that can be pressed to arbitrarily fine resolution.  In 
practice, software applications that support line art also allow integration of the two, 
with drawings including both pixelated images and line art together.  The problem with 
line art is that, except for other Microsoft applications Excel and PowerPoint, it is 
difficult to paste line drawings into Word.  Usually they have to be rendered to pixelated 
images first.  Figure C-2 shows the same zoomed graph as Figure C-1, but pasted in as a 
.pdf, which preserves the line art properties.  It looks a lot better!  At a normal 100% 
zoom, both would probably be acceptable.  But if you need to enlarge a figure, starting 
with a line art representation is much, much better.  Line drawings also typically take 
much less computer storage space than equivalent high resolution image files. 
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(Note: these figures were made by pasting into Word, zooming, then screen capture.) 
 

 
Figure C-1  Zoom 500% of figure pasted in as a pixelated image (.tiff) 

 

 
Figure C-2  Zoom 500% of figure pasted in as a Microsoft Office graphic (line art) 
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This appendix is concerned with the process of getting graphics data and images 

from various sources into Word.  Editing those graphics into a form that is presentable 
is addressed in Chapter 4 concerning figures.  Here the focus is on the porting process, 
so that those nicely constructed figures will also look good in your report.  The 
assumption is that you are not a graphics professional; you are a student limited to the 
commonly available programs.  If you were writing a book, your publisher would use 
professional grade (and expensive) software to do layout, and to port and render 
graphics to a quality expected at today’s textbook prices.  But as a student doing a 
laboratory report, you don’t have the time or resources to do that.  That is also true in 
the professional domain.  If your report is sufficiently important, perhaps it will be given 
a makeover by your firm’s publications department before it is disseminated to 
prospective clients.  Your job is to make the contents as presentable and effective as you 
can within the means you have available. 

 
The remainder of this appendix is in sections that address ports from particular 

software packages that you are likely to use. 
 

Ports from Excel: 
So, you have carefully constructed a graph in Excel and formatted it just how you 

want it to appear in your report.  How do you get it there?  The seemingly obvious 
answer is to “Copy” from Excel and “Paste” into Word.  But there are important 
nuances. 

 
In the Word “Edit” menu, you can find “Paste” and “Paste Special …”.  What 

“Paste” does depends on the defaults that are set for your version of Word.  To fully 
control what happens, do “Paste Special” and choose the option that gives the result you 
want.  The Paste Special dialog box is shown in Figure C-3 below. 

 

 
Figure C-3  Word Paste Special Dialog Box 

 
There are two basic choices at the top: whether to paste in the graphic or whether 

to paste in a link to the graphic.  A link to the graphic allows your Word file to display a 
graphic which actually remains in your Excel file.  If you change the Excel data, the 
graph there will change, and you’ll also see the change in your Word document.  This 
can be useful, but it is also dangerous, since if you sent the Word document to your lab 
partner to review, but not the Excel file, the figure is missing.  It also means that your 
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Word document may change between when you first print it and later when you have 
done some more with Excel without even having touched the Word document.  Unless 
you are very careful and sure of your reasons for using a link, I’d recommend pasting the 
graph itself rather than just a link.  (These same methods and issues also apply to 
pasting drawings in from PowerPoint.) 

 
When pasting the graphic, you have choices.  If you paste as an Excel Chart 

Object, you can continue to edit the chart after it is in Word using the same tools that 
you have in Excel.  (But, why not do that in Excel before copying?)  A Chart Object may 
be subject to version issues in the future, since it depends on a compatible version of 
Excel.  The option to paste as a Microsoft Office Graphic object is usually best, in that 
the graphic remains in the form of “line art” that can be rendered at arbitrarily fine 
resolution.  However, it may not port to other applications, such as other word 
processors.  The safest ways to paste, if you are concerned with being able to read your 
file sometime in the future or on other platforms, is to paste as a pixelated image (.tiff) 
or as a PDF image.  The PDF image should retain the qualities of line art as Figure C-2 
shown above, while remaining a widely accessible format that should not disappear 
leaving your document with a hole where the figure should be. 

 
Ports from Cadence ORCAD (PSpice): 

Cadence is the company name (and the folder where you’ll find this electronics 
CAD suite of applications), and ORCAD is the particular CAD application used for 
design.  PSpice is the name of the simulation program.  In the early days, PSpice was a 
stand-alone program, with circuits described in text.  The monster has grown 
incrementally so that it is now a very elaborate and comprehensive (and expensive!) 
professional design tool.  Fortunately, a “lite” version is available which supports most 
educational needs.  (The lite version does not include all of the parts you’d like to use, 
and is missing the TIP-31 and TIP-32 power transistors in particular.  There are work-
arounds for that problem though.)  Various other “Spice” programs other than 
ORCAD/PSpice are available, including “LTSpice” often used in EE252.  The following 
material in this manual assumes that graphics are to be ported from the “lite” version of 
ORCADS/PSpice for use in a report, and that the same version was used for design 
schematic capture and simulation. 

 
Two types of content are likely to need porting from ORCAD/PSpice (from now 

on, simply “PSpice”) to the writer’s word processing report document.  Those are 
schematics and simulation results, the latter typically in the form of a graph. 

 
A PSpice schematic typically appears (by default) on the screen as shown in 

Figure C-4.  This figure was made by simple screen capture (using the “snipping tool”) 
after zooming in a bit to make the features larger, and hence to get better resolution of 
the captured image (a .jpg file). 
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Figure C-4  Captured PSpice design schematic (via screen capture) 

 
This may be considered marginally satisfactory as-is, but some improvement is 

possible.  First, notice the visible grid points.  These are important when building the 
circuit on screen, but are a distraction in a figure.  It is possible to get rid of them prior 
to screen capture using the Options menu in PSpice.  Under “Design Template” and 
“Schematic Page Properties” it is possible to make them not be visible.  It is also possible 
to get rid of the drawing frame and title which are generally not required or desired in a 
laboratory report.  (In industry, if you are doing a design package, documentation must 
include the frame, drawing name, version number, date, and the rest of the attributes 
necessary for project configuration control.  That’s not the case for a formal laboratory 
report which, in comparison, is rather informal!)  Figure C-5 shows the dialog boxes. 

  
Figure C-5  Grid and Page Preference Dialogs 
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The color, especially the light green, can be a problem; monochrome is better.  
Fix that in Word after inserting the image.  (Use Picture format/color, choose greyscale.)  
Figure C-6 shows the same schematic rendered in monochrome, omitting grid points.

 
Figure C-6  Captured PSpice design schematic (via screen capture, no grid points) 
 
It may be possible to capture the circuit schematic in a line oriented format.  The 

problem is getting it into a format acceptable to Word.  In PSpice, under the File menu, 
you can “export the design” in .dxf format.  That is a file format native to AutoCAD, so 
you would be able to open that file in AutoCAD.  If you can render an AutoCAD drawing 
in Word as line art, that method can be used for the schematic.  This .dxf file can be also 
opened by LibreOffice (downloadable) and exported as an unsatisfactory pdf. 

 
The second form of figure typically imported from PSpice is simulation results.  

DC circuit values are shown on the schematic and can be copied in the same manner as 
the schematic.  AC values are shown on a graph, typically appearing on the screen as 
shown in Figure C-7.  Notice that this white on black style somewhat resembles what 
might have been seen on an ancient oscilloscope.  It is not the way you want this 
information to appear in a report.  First, you want black on white, not white on black.  
(Save ink or toner!)  Second, you want only the graph proper, not the entire window.  
Third, the lettering is too small.  The labeling is deficient.  Finally, both curves (for input 
and output) are plotted against the same scale, so it is difficult to discern details on the 
smaller (input) signal.  Some things can be done to help before trying to port the image. 

 
In the PSpice display window, the “Plot / Axis Settings” allows manipulation of 

the graph in similar ways to what can be done in Excel.  It is possible to choose the range 
of values, add an axis, use a logarithmic scale, and even add additional signals.  Under 
“Tools” / “Options,” the background and foreground colors can be changed to get black 
on white.  Figure C-8 shows the dialog box used to do this superimposed with the 
reversed color scheme.  (It is also possible copy the screen shot into “Paint” and invert 
the colors.  That also results in a white / black reversal, but it also reverses the trace 
colors, which may be undesirable.)  There are additional options for setting the trace 
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colors, the cursor colors, text font, and so forth.  There are not as many options as in 
Excel, but it should be possible to produce an acceptable graphic as a pixelated image. 

 
Figure C-7  PSpice AC data output window 

 

 
Figure C-8  PSpice AC data output after reversing background and foreground colors 
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What would be more desirable is to get the graph as a line graphic of the quality 
one can expect with Excel.  That is possible, using Excel as an intermediate tool.  The 
key concept is that the simulation data that has been recorded can be “Exported” as a 
text file that Excel can read.  Under the File menu, choose to export as a “.csv” file.  That 
is a text based format that Excel can read.  (You have to tell Excel to look for any 
readable format.)  Once the data is read into Excel, it looks as shown in Figure C-9.  
(Only the first score or so of lines are seen; it’s a long file.)  The three columns are time 
plus the values of the two traces.  Now that the data is in Excel, it can be graphed using 
the usual Excel tools, as shown in Figure C-10. 

 

 
Figure C-9  Excel data from PSpice 

 
It is possible to improve on this graph by changing the units in Excel to milliseconds and 
milliVolts by creating three new columns, derived from the original data by multiplying 
by 1000.  Then the units allow integer numbers, which is a bit more pleasing in 
appearance.  Once the data is in Excel it is possible to get a very presentable figure, and 
it is just as authentic and exact as what was portrayed in the PSpice program originally, 
since it is using the same data.  (This figure was pasted into this manual as a .pdf.) 

 
Many other programs also support the export of data in formats that can be read 

in Excel.  Look for that in other discipline specific applications, for example the National 
Instruments Virtual Instruments (used in SLC224).  Often the acceptable format is 
called a “comma delimited text file” or even just “text”.  Many pieces of test equipment 
support data export to an attached computer using a serial port, USB, or IEEE 488. 
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Figure C-10  PSpice data exported to and rendered using Excel 

 
Ports from MATLAB: 
 The MATLAB program used for doing engineering calculations and programming 
provides facilities for generating plots.  Getting these plots back into a Word document 
in a suitable manner is the issue.  As with other applications used to generate graphs, it 
helps to make the figure as close to what you want as possible before you port it. 

The most basic MATLAB command for creating a graph is “plot”.  It can be used 
to plot one or more sets of values on the vertical axis.  Figure C-11 shows a plot of the 
capacitor Voltage and Current data from Table 1 of Chapter 4.  The figure was saved as a 
.jpg file and inserted into this Word document. Vectors v, a, and t represented the values 
of Voltage, Current, and Time respectively.  These were plotted using the commands: 

 
>> v=[0 1.97 3.16 3.88 4.32 4.59 4.85 4.94]; 
>> t=[0 .1 .2 .3 .4 .5 .7 .9]; 
>> a=[.1 .061 .037 .022 .013 .008 .003 .001]; 
>> plot(t,v,'ko-',t,a,'ks--'); 
 
The text strings included in the plot command make both sets of data plotted in black 
(k), and designates round (o) or square (s) markers and solid (-) or dashed (--) lines.  
The graph shown does not yet have labels or grid lines.  There are commands that can be 
used to do those things.  (The MATLAB “help” documentation is very helpful; use it.)  
The most serious problem, however, is that both dependent variables use the same 
scale, and that cannot produce a satisfactory graph. 
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Figure C-11 MATLAB plot of two variables using the ‘plot’ function 

 
There is a plot command that provides two axes, ‘plotyy’.  That command does 

not allow such easy specification of markers and lines, however.  One must accept 
defaults or use separate (and more complicated) commands later to set the colors and 
other attributes.  The use of the command plotyy as follows produces Figure C-12. 

 
>> [AX,H1,H2]=plotyy(t,v,t,a,'plot'); % default axes are blue, green. 
 

 
Figure C-12  MATLAB plot of two variables using ‘plotyy’ command 

 
The command without the “[AX,H1,H2]=” would do the same thing, but returning 

the axis pointer AX and data pointers H1 and H2 allows subsequent commands to 
improve the figure.  In this case, the commands executed subsequently were: 
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>> set(H1,'Color','k'); 
>> set(H2,'Color','k'); 
>> set(H1,'LineStyle','-'); 
>> set(H2,'LineStyle','--'); 
>> set(H1,'MarkerFaceColor','k'); 
>> set(get(AX(1),'Ylabel'),'Color','k'); 
>> set(get(AX(2),'Ylabel'),'Color','k'); 
>> grid on; 
 
These produced the graph shown in Figure C-13 below.  This still has problems.  

Markers need to be specified and the vertical axes and labels need to be colored black. 
 

 
Figure C-13  MATLAB modified ‘plotyy’ figure 

 
MATLAB provides a second way of editing figures, in the figure window, once 

they are produced.  In the “Views” menu of that window, the Properties Editor can be 
invoked, which allows direct access to the various attributes of axes, the figure 
background, and various other things.  Using the tools therein, the figure above was 
edited to the form shown in Figure C-14 (on next page). 

 
It is also possible to build up a plot in MATLAB line by line, adding and editing 

the properties of axes as you go.  See the MATLAB documentation of how to do plots 
with multiple axes.  That is probably the best way to do more complex graphs, such as 
one having multiple variables, with some being linear and some being logarithmic.  
Simpler log plots can use the ‘loglog’, ‘semilogx’ or ‘semilogy’ commands.  MATLAB also 
supports three dimensional plots.  These topics are beyond the scope of what this 
manual can address.  Our main concern here is how to get those figures back into a 
Word document.  Figured C-11 to C-13 were ported by saving them as .jpg files within 
MATLAB, then inserting them into the Word document as pixelated graphics.  That does 
not necessarily produce the best graphic, but it is simple, and adequate in many cases. 
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Figure C-14  MATLAB graph after editing in the figure editing window. 

 
Figure C-14 was saved from MATLAB as an “.emf” fomat file, which stands for 

“Enhanced Metafile”.  The file opened in LibreOffice and from there was pasted into 
Word, but remains pixelated rather than a line graphic.  (It may be that one of the other 
formats that preserve line features, .ai or .eps, can be used.  Or perhaps more recent 
updates to MATLAB provide a save format that can be transitioned to Word as line art.  
What you don’t want to do is transfer by screen shot; that preserves a grey background.) 

 
Another strategy for getting good graphics is to have MATLAB print out the data 

to be graphed into a comma (or tab) delimited text file that can then be opened in Excel.  
Then Excel can be used to produce a satisfactory graph which can be pasted into Word 
as line art, avoiding the problems with pixelated graphics.  For example, in the MATLAB 
context of the capacitor data above, one could include in a script (or type to the 
command window) the following commands: 

 
>> fp=fopen(‘capdataout.txt’,’w’); 
>> for i=1:8, fprintf(fp,’%f, %f, %f\n’,t(i),v(i),a(i)),end; 
>> fclose(fp); 
 
This produces a comma delimited file.  When opening the file with Excel, it is 

necessary to specify that it is comma delimited text.  Once opened, it appears as seen in 
Figure C-15 below.  (The columns were reformatted to fixed point style.)  Now Excel, 
with all of its graphing tools, can be used to produce the same graph seen earlier as 
Figure 5-1 of Chapter 5, which can be copied in as line art. 

 

 
Figure C-15  Comma delimited text opened by Excel 
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Ports from PowerPoint: 
 
Microsoft PowerPoint is an application for developing “viewgraph” presentations.  

As such it has facilities for drawing diagrams. Word itself has some limited facilities for 
inserting shapes and doing drawing.  In both cases, these drawings are “line art” in the 
sense that they are not rendered into pixels until displayed or printed, and thus 
maintain sharpness while being stretched or otherwise manipulated.  The danger of 
doing this drawing in Word is that the elements may not stay together if they are 
independently placed on a page.  If the document is edited and the drawing is bumped 
to the next page, some but not all elements of the drawing may move, breaking up the 
figure.  This problem can be avoided by ensuring that all figure elements are “grouped” 
(using the “arrange” options).  Using PowerPoint as an application for doing drawings is 
perhaps a better way to ensure that the drawing stays coherent.  Also, Word does not 
have as many tools and options as PowerPoint does.  So, we assume here that 
PowerPoint is essentially used as a drawing program to prepare figures to be pasted into 
Word. 

 
When a new “PowerPoint Presentation” is created, it begins with one “slide” 

(illustration) that has two big text boxes, one for a title and the other for a subtitle and 
other contents.  These are easily deleted, leaving a blank sheet on which one may add 
“shapes” (line art elements) and “pictures” (pixelated images from other files) and “text 
boxes”.  The “shapes” available are many and varied, but include basic lines, boxes, and 
circles or arcs from which one can build up many different complex figure elements.  
Under the “View” menu, on can find under “Guide” the option  to “Snap to Grid”, which 
is essential for drawing with any precision.  The Ruler option under the View menu is 
also very helpful.  Unfortunately, PowerPoint does not provide an option to show the 
grid, but choosing a background (under Format menu, slide background) and a pattern 
fill of “large grid” (with a color change to something like light grey) does give a helpful 
background for drawing, even if not exactly aligned with the grid.  By using the basic 
shapes, using “group” and “align” and tools to change colors, one can build up elements 
of a diagram or schematic such as the “spring” representation seen in Figure C-16 below. 

 

 
Figure C-16  A “spring” from PowerPoint 

 
This particular component was made up of paired arcs, grouped, then duplicated 

three times, then aligned horizontally and grouped again with lines representing the 
connecting terminals.  Eventually, elements can be combined to construct a figure that 
can be ported to Word.   

Figure C-17 shows such a figure, still in Powerpoint, with the background pattern 
visible that helped with aligning elements.  (This is from a “screen shot”)  When 
completed and pasted into Word as a Microsoft Office Graphic Object, be sure to group 
all the figure elements together before copying, or they will very likely  come out 
scattered across the page.  As a graphic object, as you change the size and shape of the 
figure in Word, the text sizes and line widths remain the same rather than changing in 
proportion to size.  (See Figure C-18.)  So, in PowerPoint it is best to make the figure size 
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comparable to what you will want it to be in Word.  In this case, the line widths (4 points 
in PowerPoint) are too thick and the text boxes, with 18 point lettering, when resized are 
too small to show the text.  It is possible to make some adjustments in PowerPoint, but 
the adjusted grouped figure, even if it looks good in PowerPoint, may not paste correctly 
into Word as seen in Figures C-19 and C-20 below. 

 
Figure C-17  Screen shot of figure as drawn, seen in PowerPoint 

 

 
(Note: text boxes are too small to show the text!) 

 
Figure C-18  Same figure pasted as Microsoft Office Graphic Object then resized smaller 

 

 
Figure C-19  PowerPoint figure with smaller widths, type size, resized while grouped 

 

 
Figure C-20  How PowerPoint figure shown above comes out pasted into Word. 
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PowerPoint is not an adequate substitute for a real drawing program like Adobe 
Illustrator or Visio, but can be useful for doing relatively simple figures like block 
diagrams and schematics.  Graphics brought in from PowerPoint as Microsoft Office 
Graphic Objects are genuine line art and retain their sharpness.  However, there are 
pitfalls.  It is best to construct the diagram in PowerPoint at the same size you will want 
it to appear in Word, and you need to be sure to “Group” the figure into one object prior 
to copying and pasting.  With those precautions, PowerPoint can be a useful tool for 
constructing figures for use in laboratory reports. 

 
Ports from Paint: 
 Microsoft Paint is a simple “accessory” application that can be useful for 
modifying or even creating figures.  The images modified or constructed are pixelated, 
and are limited to the resolution that is available when created.  While it is possible to 
“invert” an image (take a negative of it), more sophisticated tools for adjusting color tint, 
saturation, sharpness and contrast are absent.  Fortunately, tools to do many of those 
things are available in Word.  So, an image can be taken, say from a photograph or an 
application screen shot, annotated in Paint, further manipulated in Word, and give a 
satisfactory figure.  Pasting in such figures is straightforward. 
 


